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Introduction to Tables and Charts in Word

Importance of Tables and Charts in Engineering Documentation:
Visual presentation of data is essential in technical communication. Tables and charts 
enable:
• Organized presentation of experimental data and measurements
• Clear comparison of specifications and parameters
• Visual representation of trends and relationships
• Professional appearance in lab reports and technical papers
• Efficient communication of complex numerical information
Tables in Engineering:
• Equipment specifications and component lists
• Experimental data and measurement results
• Comparison matrices for design alternatives
• Bill of materials (BOM) for projects
• Test procedures and checklists
• Truth tables and state transition tables



Introduction to Tables and Charts in Word

Charts in Engineering:
• Voltage and current waveforms
• Frequency response curves
• Performance comparisons
• Statistical analysis results
• Project timelines and schedules
• Data trends and correlations
Word vs. Excel:
• Word: Best for simple tables integrated into text documents
• Excel: Better for complex calculations and data analysis
• Integration: Excel charts and tables can be embedded in Word documents



Creating Tables - Basic Methods

Method 1 - Insert Table Grid:
1. Insert tab → Tables group → Table
2. Hover over grid to select desired rows and columns (up to 10×8)
3. Click to insert table at cursor position
4. Quick and visual method for small tables

Method 2 - Insert Table Dialog:
1. Insert tab → Tables group → Table → Insert Table
2. Specify number of columns and rows
3. Choose AutoFit behavior: 
• Fixed column width: Specify width or use Auto
• AutoFit to contents: Columns adjust to fit text
• AutoFit to window: Table spans page width

4. Click OK
5. Best for precise control and larger tables



Creating Tables - Basic Methods

Method 3 - Draw Table:
1. Insert tab → Tables group → Table → Draw Table
2. Cursor becomes pencil tool
3. Draw table outline, then draw internal rows and columns
4. Useful for irregular table structures
5. Table Tools Design tab → Draw Borders group → Eraser to remove lines

Method 4 - Quick Tables:
1. Insert tab → Tables group → Table → Quick Tables
2. Select from pre-formatted table templates
3. Replace placeholder content with your data
4. Includes calendars, tabular lists, and matrices



Table Structure and Navigation
Table Components:
• Cell: Individual box containing data (intersection of row and column)
• Row: Horizontal series of cells
• Column: Vertical series of cells
• Header Row: First row containing column labels
• Border: Lines defining cell boundaries
• Gridlines: Non-printing lines showing cell structure
Navigating Tables:
• Tab key: Move to next cell (right), creates new row at end
• Shift + Tab: Move to previous cell (left)
• Arrow keys: Move between cells
• Mouse click: Select specific cell
• Alt + Home: First cell in row
• Alt + End: Last cell in row
• Alt + Page Up: First cell in column



Table Structure and Navigation

Navigating Tables (continuation):
• Alt + Page Down: Last cell in column
Selecting Table Elements:
• Cell: Click inside cell, or click left cell edge
• Row: Click left margin next to row
• Column: Click top border of column (cursor becomes down arrow)
• Multiple cells: Click and drag, or Shift + arrow keys
• Entire table: Click table move handle (four-headed arrow at top-left)
• Table Tools Layout tab → Select: Choose row, column, cell, or table
Entering Data:
• Click cell and type
• Tab to move to next cell
• Enter key creates new paragraph within cell
• Paste data from Excel or other sources



Modifying Table Structure

Inserting Rows and Columns:
Method 1 - Right-Click Context Menu:

1. Right-click in cell where insertion needed
2. Select Insert → Insert Rows Above/Below or Insert Columns Left/Right
3. New row or column appears

Method 2 - Table Tools Layout Tab:
1. Click in cell adjacent to insertion point
2. Table Tools Layout tab → Rows & Columns group
3. Click Insert Above, Insert Below, Insert Left, or Insert Right
4. Multiple rows/columns: Select multiple cells first, then insert

Quick Insert:
• Hover mouse outside table between rows or columns
• Click the + button that appears
• Instantly inserts row or column



Modifying Table Structure

Deleting Rows, Columns, and Cells:
1. Select rows, columns, or cells to delete
2. Table Tools Layout tab → Rows & Columns group → Delete
3. Choose: Delete Cells, Delete Columns, Delete Rows, or Delete Table
4. Or right-click → Delete Cells/Rows/Columns

Delete Options for Cells:
• Shift cells left: Remaining cells move left
• Shift cells up: Remaining cells move up
• Delete entire row
• Delete entire column



Modifying Table Structure

Merging and Splitting Cells:
• Merge Cells: Combine multiple cells into one
• Select cells → Table Tools Layout tab → Merge group → Merge Cells
• Or right-click → Merge Cells

• Split Cells: Divide one cell into multiple cells
• Select cell → Layout tab → Merge group → Split Cells
• Specify number of columns and rows



Table Formatting - Borders and Shading

Applying Borders:
Borders define cell boundaries and enhance table appearance.

Method 1 - Borders Button:
1. Select cells, rows, columns, or entire table
2. Table Tools Design tab → Borders group → Borders dropdown
3. Choose border style: All Borders, Outside Borders, Inside Borders, etc.
4. Or Home tab → Paragraph group → Borders button

Method 2 - Borders and Shading Dialog:
1. Select table elements
2. Table Tools Design tab → Borders group → Borders → Borders and Shading
3. Choose: 
• Setting: None, Box, All, Grid, Custom
• Style: Line style (solid, dashed, dotted, double)
• Color: Border color
• Width: Line thickness (0.5 pt to 6 pt)



Table Formatting - Borders and Shading

4. Preview shows current selection
5. Apply to: Cell, Table, or specific edges

Custom Borders:
• Click specific edges in preview to add/remove borders
• Apply different styles to different edges
• Create professional table designs
Applying Shading:
Background color for cells, rows, or columns to emphasize information.

1. Select cells to shade
2. Table Tools Design tab → Table Styles group → Shading
3. Choose color from palette
4. Or Borders and Shading dialog → Shading tab



Table Formatting - Borders and Shading

Engineering Table Best Practices:
• Header row: Bold text with shading (light gray or theme color)
• Data rows: Alternating row colors for readability (optional)
• Borders: Clear, consistent lines (avoid excessive decoration)
• Professional appearance: Subtle colors, clear structure



Table Styles and Design

Table Styles:
Pre-designed combinations of borders, shading, fonts, and colors providing 
professional appearance with single click.
Applying Table Styles:

1. Click anywhere in table
2. Table Tools Design tab → Table Styles group
3. Hover over styles to preview
4. Click to apply style
5. More button (▼) shows complete gallery

Table Style Options:
Table Tools Design tab → Table Styles group → Table Style Options
• Header Row: Special formatting for first row
• Total Row: Special formatting for last row
• Banded Rows: Alternating row colors for readability
• First Column: Emphasis on first column (row labels)



Table Styles and Design

Table Style Options (continuation):
• Last Column: Emphasis on last column (totals)
• Banded Columns: Alternating column colors
Modifying Table Styles:

1. Right-click table style in gallery
2. Select Modify Table Style
3. Adjust formatting for different table elements
4. Save as new style for reuse

Creating Custom Table Styles:
1. Format table manually with desired appearance
2. Table Tools Design tab → Table Styles → New Table Style
3. Name the style
4. Set formatting for each table element
5. Save for current document or all documents



Table Styles and Design

Engineering Documentation:
• Use subtle, professional styles
• Ensure readability (sufficient contrast)
• Maintain consistency across document
• Consider black-and-white printing



Table Properties and Layout

Table Properties Dialog:
Access: Right-click table → Table Properties, or Table Tools Layout tab → Table group → 
Properties
Table Tab:
• Size: Set preferred table width (inches, percentage, or auto)
• Alignment: Left, Center, Right, or specific indent
• Text Wrapping: None (table on separate line) or Around (text flows around table)
• Positioning: Exact position on page (for wrapped tables)
• Borders and Shading: Quick access to formatting
Row Tab:
• Specify height: Set exact row height or minimum height
• Allow row to break across pages: Enable/disable for long rows
• Repeat as header row: Repeat header on each page (multi-page tables)



Table Properties and Layout

Column Tab:
• Preferred width: Set column width precisely
• Previous/Next Column: Navigate between columns
Cell Tab:
• Preferred width: Individual cell width
• Vertical alignment: Top, Center, Bottom
• Options: Cell margins and text wrapping within cell
Alt Text Tab:
• Title and Description: Accessibility information for screen readers
• Important for accessible documents



Advanced Table Features

Repeating Header Rows:
For tables spanning multiple pages, header row can repeat automatically.

1. Select header row(s)
2. Table Tools Layout tab → Data group → Repeat Header Rows
3. Or Table Properties → Row tab → Check "Repeat as header row at the top of 

each page"
4. Header appears on each page automatically

Text Direction:
Change text orientation within cells (useful for narrow columns).

1. Select cells
2. Table Tools Layout tab → Alignment group → Text Direction
3. Click repeatedly to cycle through orientations (horizontal, vertical rotated) le



Advanced Table Features

Cell Alignment:
Combine horizontal and vertical alignment for precise positioning.
• Table Tools Layout tab → Alignment group
• Nine alignment options: Top Left, Top Center, Top Right, Center Left, Center, Center 
Right, Bottom Left, Bottom Center, Bottom Right
Cell Margins:
Control spacing between cell borders and content.

1. Table Tools Layout tab → Alignment group → Cell Margins
2. Set Top, Bottom, Left, Right margins
3. Apply to whole table or selected cells



Advanced Table Features

Sorting Table Data:
Organize table rows alphabetically or numerically.

1. Select table (or specific rows)
2. Table Tools Layout tab → Data group → Sort
3. Choose sort column and order (ascending/descending)
4. Specify header row presence
5. Add secondary and tertiary sort levels

Converting Tables:
• Table to Text: Layout tab → Data group → Convert to Text (choose separator)
• Text to Table: Select text → Insert tab → Table → Convert Text to Table



Calculations in Word Tables

Formula Feature:
Word can perform basic calculations within tables, useful for simple computations 
without Excel.
Inserting Formulas:

1. Click in cell where result should appear
2. Table Tools Layout tab → Data group → Formula
3. Formula dialog appears with suggested formula
4. Modify or enter custom formula
5. Choose number format
6. Click OK

Common Functions:
• SUM(): Add values - =SUM(ABOVE), =SUM(LEFT), =SUM(A1:A5)
• AVERAGE(): Calculate mean - =AVERAGE(ABOVE)
• COUNT(): Count numeric values - =COUNT(LEFT)



Calculations in Word Tables

Common Functions (continuation):
• MAX(): Find maximum value - =MAX(ABOVE)
• MIN(): Find minimum value - =MIN(ABOVE)
• PRODUCT(): Multiply values - =PRODUCT(LEFT)
Cell References:
• Positional: ABOVE, BELOW, LEFT, RIGHT
• Specific: A1, B2, C3 (columns A-Z, rows 1-n)
• Range: A1:A5, B2:D2
Arithmetic Operators:
• Addition: +
• Subtraction: -
• Multiplication: *
• Division: /



Calculations in Word Tables

Example - Engineering Application:
Calculate total resistance in series circuit:
• Column A: Resistor values (R1, R2, R3)
• Cell A4: =SUM(ABOVE) for total resistance
Updating Formulas:
• Right-click cell → Update Field (or press F9)
• Formulas don't auto-update like Excel
Limitations:
• Basic calculations only
• No complex functions
• Manual updates required
• For extensive calculations, use Excel



Introduction to Charts in Word
Why Use Charts?
Charts transform numerical data into visual representations, making patterns, trends, 
and comparisons immediately apparent.
Benefits in Engineering Documentation:
• Visualize experimental results and measurements
• Compare performance across different conditions
• Show trends over time or frequency
• Present statistical analysis results
• Communicate complex data clearly and professionally
Chart Types Available in Word:
• Column/Bar Charts: Compare discrete values
• Line Charts: Show trends over time or continuous variables
• Pie Charts: Display proportional relationships
• Area Charts: Emphasize magnitude of change over time
• Scatter (XY) Charts: Show correlation between two variables



Introduction to Charts in Word

Chart Types Available in Word (continuation):
• Surface Charts: Display 3D data relationships
• Radar Charts: Compare multiple variables
• Combo Charts: Combine different chart types
Word vs. Excel for Charts:
• Word: Suitable for simple charts with limited data
• Excel: Better for complex data analysis and advanced charting
• Best Practice: Create chart in Excel, embed in Word document for dynamic updates
Chart Components:
• Data Series: Set of related data points
• Axes: Horizontal (X) and vertical (Y) reference lines
• Legend: Key identifying data series
• Title: Descriptive chart heading
• Gridlines: Reference lines for reading values
• Data Labels: Values displayed on data points



Creating Charts in Word

Method 1 - Insert Chart (Built-in Data):
1. Position cursor where chart should appear
2. Insert tab → Illustrations group → Chart
3. Choose chart type from gallery (Column, Line, Pie, etc.)
4. Click OK
5. Excel worksheet opens with sample data
6. Replace sample data with your actual data
7. Close Excel window
8. Chart appears in Word document

Editing Chart Data:
1. Click chart to select
2. Chart Tools Design tab → Data group → Edit Data
3. Excel worksheet reopens
4. Modify data as needed
5. Chart updates automatically
6. Close Excel window



Creating Charts in Word

Method 2 - Copy Chart from Excel:
1. Create chart in Excel with full functionality
2. Select chart in Excel
3. Copy (Ctrl+C)
4. Switch to Word document
5. Paste (Ctrl+V)
6. Choose paste option: 
• Use Destination Theme & Embed Workbook: Chart matches Word theme, data editable
• Keep Source Formatting & Embed Workbook: Retains Excel formatting, data editable
• Use Destination Theme & Link Data: Chart updates when Excel file changes
• Keep Source Formatting & Link Data: Retains Excel formatting, linked to source
• Picture: Static image, not editable

Recommended Approach for Engineering:
Create complex charts in Excel for full analytical capabilities, then embed or link in Word 
document for professional reports.



Chart Types for Engineering Applications

Column and Bar Charts:
• Use: Compare discrete values across categories
• Engineering Applications:
• Compare component specifications
• Show test results for different conditions
• Display measurement data for multiple samples
• Present survey or experimental group comparisons

• Column: Vertical bars (categories on X-axis)
• Bar: Horizontal bars (categories on Y-axis)
• Clustered: Multiple series side-by-side
• Stacked: Series stacked on top of each other

Line Charts:
• Use: Show trends over time or continuous variables



Chart Types for Engineering Applications

• Engineering Applications:
• Voltage/current waveforms over time
• Temperature variations during experiments
• Frequency response curves
• Signal processing results
• Performance trends across parameter ranges

• Best for: Continuous data, time series, multiple data series comparison
Scatter (XY) Charts:
• Use: Show relationship between two continuous variables
• Engineering Applications:
• Voltage vs. current (I-V characteristics)
• Input vs. output relationships
• Correlation analysis
• Experimental data with independent and dependent variables



Chart Types for Engineering Applications

• Engineering Applications (continuation):
• Trendlines: Add linear, polynomial, or exponential regression lines
• Most important: For scientific and engineering data analysis

Pie Charts:
• Use: Show proportional relationships (parts of whole)
• Engineering Applications:

• Power distribution in circuits
• Budget allocation for projects
• Component cost breakdown
• Time allocation for project phases

• Limitation: Use only for one data series, avoid for more than 6-7 
categories



Formatting and Customizing Charts

Chart Tools Contextual Tabs:
When chart is selected, two contextual tabs appear:
• Design Tab: Chart type, data, layouts, styles
• Format Tab: Shape styles, text formatting, size, arrangement
Chart Design Tab:
Add Chart Element:
• Chart Title: Above chart, centered overlay, or none
• Axis Titles: Horizontal and vertical axis labels
• Legend: Position (right, top, bottom, left) or none
• Data Labels: Display values on data points
• Data Table: Show data below chart
• Gridlines: Major and minor gridlines for axes
• Trendline: Regression lines for scatter charts



Formatting and Customizing Charts

Quick Layout:
Pre-designed combinations of chart elements
• Choose from gallery of layouts
• Instant professional appearance
Change Colors:
• Select from color schemes
• Coordinate with document theme
Chart Styles:
• Pre-designed combinations of colors and effects
• Hover to preview, click to apply
Switch Row/Column:
• Swap data series and categories
• Changes chart perspective



Formatting and Customizing Charts

Select Data:
• Modify data range
• Add/remove data series
• Edit series names and values



Advanced Chart Formatting

Format Chart Area:
Right-click chart background → Format Chart Area
• Fill: Solid, gradient, picture, or pattern
• Border: Line style, color, width
• Shadow and 3-D Effects: Visual enhancements
• Size and Properties: Exact dimensions and positioning
Format Axes:
Right-click axis → Format Axis
• Axis Options:
• Minimum and maximum bounds
• Major and minor units (tick marks)
• Logarithmic scale (for wide data ranges)
• Reverse axis direction
• Axis position (on tick marks or between)



Advanced Chart Formatting

• Axis Options (continuation):
• Number Format: Decimal places, currency, percentage, scientific 
notation
• Tick Marks: Major and minor tick mark style
• Labels: Position and orientation

Format Data Series:
Right-click data series → Format Data Series
• Series Options:
• Gap width (spacing between bars/columns)
• Overlap (for clustered charts)
• Secondary axis (for dual-scale charts)

• Fill and Border: Colors and line styles
• Marker Options: Shape, size, fill (for line and scatter charts)
• Data Labels: Position, content, formatting



Advanced Chart Formatting

Format Legend:
• Position: Right, top, bottom, left, or custom
• Fill and border formatting
• Font and text formatting
• Size and alignment
Format Gridlines:
• Line style, color, width
• Major and minor gridlines
• Transparency



Best Practices for Tables and Charts

Table Best Practices:
Design and Structure:
• Use clear, descriptive column headers
• Keep tables simple and focused (avoid excessive columns)
• Align numbers right, text left for readability
• Use consistent decimal places for numerical data
• Apply subtle shading to header row
• Consider alternating row colors for large tables
Content:
• Include units in column headers (Voltage (V), Current (mA))
• Use appropriate precision (don't over-specify decimal places)
• Add table caption above table with descriptive title
• Number tables sequentially (Table 1, Table 2, etc.)
• Reference tables in text ("as shown in Table 3")



Best Practices for Tables and Charts

Formatting:
• Maintain consistency across all tables in document
• Use professional, subtle colors
• Ensure readability in black-and-white printing
• Avoid excessive borders and decoration
• Test appearance in print preview
Chart Best Practices:
Design and Clarity:
• Choose appropriate chart type for data and message
• Include descriptive chart title
• Label axes with variable names and units
• Add legend when multiple data series present
• Use gridlines sparingly (only if needed for reading values)
• Ensure sufficient contrast between data series



Best Practices for Tables and Charts

Data Presentation:
• Start Y-axis at zero for bar/column charts (avoid misleading scaling)
• Use appropriate axis scales (linear or logarithmic)
• Limit number of data series (3-5 maximum for clarity)
• Add trendlines for scatter plots when showing relationships
• Include data labels only when specific values are important
Professional Quality:
• Match chart colors to document theme
• Use consistent formatting across all charts
• Add figure caption below chart with descriptive title
• Number figures sequentially (Figure 1, Figure 2, etc.)
• Reference figures in text ("as illustrated in Figure 5")
• Ensure chart is large enough to read clearly



Best Practices for Tables and Charts

Engineering Documentation Standards:
• Follow institutional or publication style guidelines
• Include uncertainty or error bars when appropriate
• Cite data sources if not original
• Maintain scientific integrity in data presentation
• Avoid chart junk (unnecessary decoration)
Integration with Text:
• Introduce tables and charts in text before they appear
• Explain significance of data presented
• Don't rely solely on visuals—provide textual analysis
• Place tables and charts near relevant text discussion
• Use cross-references for easy navigation



Questions &Answers
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